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Disclaimer 

Please note this user guide has been created by Arkance UK for internal use of our 
TryDynamicMaps (demonstration) version of MapThat. It includes examples of how to use 
MapThat using data from the Liverpool area, although the data shown in the screenshots is not 
up to date and does not reflect the current version of any spatial data in Liverpool. 
 
The user guide provides details of all Tools and Configuration options available within the system. 
This may include Tools, Menus, Icons, Searches and Data that is not available in the version of 
MapThat that you may be using. It is therefore to be used as an example of how the mapping 
application can be configured. It will not necessarily reflect how MapThat has been implemented 
either within your organisation or your local authority. 
 
If you have any questions with regards to the system, or the results from running any spatial 
analysis, please contact either your system administrator, or your local authority.  
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Copyright 

MapThat 
 
Prepared and produced by:  
 

 
 
 
ARKANCE UK Ltd. 

5 Brayford Square 

Brayford Square 

London 

E1 0SG 

 

Tel: +44 (0)330 551 9420 

 
 
Email: info.uk@arkance.world 

Website: https://arkance.world/gb-en/ 

 
 
“Let’s advance the way we work together to build a better world” – this is the vision that guides 

success for ARKANCE and its customers. A subsidiary of the French B2B services group 

MONNOYEUR, ARKANCE was founded in 2018 to become the leading digitalization partner for 

the construction and manufacturing sectors. Fueled by its innovative ‘Partner to Build Smarter’ 

strategy, ARKANCE combines its own purpose-built Be.Smart software portfolio and expert 

professional services with solutions from a network of world-class technology partners. With 

over 1300 employees spread throughout 50 locations worldwide, ARKANCE is a recognized leader 

in digital transformation across the construction, manufacturing, and infrastructure sectors. 

  
 
Copyright © 2025 ARKANCE UK Ltd. 
 
 
All Rights Reserved:  No part of this publication may be reproduced, stored in a retrieval 

system or transmitted in any form or by any means, electronic, mechanical, photocopying, 

recording, scanning or otherwise, except under the terms of the Copyright, Designs and Patents 

Act 1988 or under the terms of a licence issued by the Copyright Licensing Agency Ltd, 90 

Tottenham Court Road, London, W1T 4LP, UK, without the permission in writing of the 

Publisher. Requests to the Publisher for permission should be addressed to the Training 

Manager, Arkance UK Ltd, 5 Brayford Square, Brayford Square, London,E1 0SG. 

 

mailto:info.uk@arkance.world
https://arkance.world/gb-en/
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Support 

Arkance are experts in providing dedicated support services both during and after 

implementation of your chosen geospatial solution. As experts in both WebGIS applications and 

Open-Source GIS we can make your journey to implementing an Open-Source GIS solution as 

simple as possible. If you have a support query, please contact our customer services team: 

support.uk@arkance.world 

 

 

 

 

Arkance Community 

Arkance offer a freely available online forum for Autodesk and 

DynamicMaps solutions. The forum provides blogs, FAQs, help 

videos and tips and tricks on many different topics. 

 

To access the forum, use the following web link: https://www.cadlinecommunity.co.uk/hc/en-

us 

 

https://www.cadlinecommunity.co.uk/hc/en-us
https://www.cadlinecommunity.co.uk/hc/en-us
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Welcome to MapThat 

 

Welcome to the Arkance UK web Mapping Application - MapThat  

 

MapThat is part of DynamicMaps Suite, and it is an interactive mapping tool that provides all 

members of staff access to the wealth of spatial information held by the company. Spatial 

information can be anything from streetlight locations to assets and planning applications to 

indices of deprivation. 

The MapThat system provides the ability to look at data in its geographical context alongside 

other datasets. A searchable library of data means a user can find out what data is available and 

if permissions allow bring it into the tool to use it. 

It provides a suite of data tools allowing users to create and maintain their data. There are search 

and filter tools for the interrogation of data and export and print tools to export your results. 

The system is being further developed with improved functionality and new sets of data added 

on an on-going basis. The data and tools available within the system is driven by the needs of our 

community and our team will work to progress any requests. 
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1.0 Accessing MapThat 

 

1.1 Logging into MapThat 

MapThat can be accessed via a web URL without having to use the login page. In addition, a tick 

box may be provided that allows you to access MapThat - without logging in - as a default user. 

However, dependent on your organisation and role, you may need to login to MapThat with a 

username and password.  Simply type your name and password into the two boxes provided and 

press Login.  

 

Using the image icons below the login, you can also access helpful web pages and online help 

tools. 

Note that there is a version number at the top of the login page, which provides an updated list 

of the latest enhancements. 
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If allowed, you can also Reset your password. Choose the Reset Password icon and on 

the Reset Password page, you will need to enter your current password and then choose 

a new password. 

 

Note – you will need to confirm your new password and if spelt incorrectly the system will flag 

an error. 

 

 

 

 

 

 

 

 

 

You may also need to follow certain Password Strength rules. 
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In addition, your System Administrator may have enabled 2-Factor Authentication. If this is the 

case, you will be emailed a 4-digit passcode… 

 

 

… which you should enter into the Authentication Code window before being able to login. 

 

 

1.2 Projects 

Depending on your login credentials you may have a number of different Roles within MapThat, 

e.g. Admin, Read Only, Engineer, Data Entry. Having then chosen your specific Role, the Projects 

list will update to provide you with a list of Projects available to you. Using the Projects window, 

you can also search for a project by typing its name. As you type, the list of available Projects will 

be filtered for you. 
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Dependent on the project chosen, MapThat will be configured to display certain map datasets 

and the tools available to you.  

 

Note – If your login credentials only have one Role and one Project then the Roles and Project 

screen will be bypassed, and you will be logged directly into MapThat. 

 

 

For specific Projects, once you login you may see a Project Overview panel, which can provide 

details of the purpose of the project and contact details of the MapThat Administrator. 
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2.0 Map Window 

2.1 Base Maps 

MapThat provides you with access to a number of background mapping layers. These can be split 

between categories, such as ROADS and AERIAL mapping. 

 

 

 

 

 

 

 

 

 

 

To change the base map layer, simply click on the small map window in the bottom left of the 

map, and then choose from the list of available basemaps and the mapping will automatically 

change, for example here is OS ZoomStack: 
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Another example is Google Hybrid. 

 

2.2 Map Overview 

In addition to choosing a Basemap you can also view an Overview Map to provide context to your 

current map location. From the Map Tools List choose Map Preferences and toggle the button 

that says View/Hide Map Overview.  
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Each time that you zoom into the main map window the Overview map updates. 

 

 

2.3 Scale and Map Coordinates 

As you pan and zoom around the map, the maps scale and coordinates will automatically update. 

These can be found in the bottom left-hand corner of the map window. In addition to the map 

scale, we also show your current Zoom Level. 

 

Coordinates can also be shown using WGS 84 Transverse Mercator. 
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2.4 Map Full Screen 

The map window takes up a majority of the browser page, with a Layers Panel and the main 

toolbar at the top of the map. In addition, you will see all your browser favourites, the URL for 

the current map and the computer taskbar icons at the bottom of the screen. 

 

If you wish to make full use of the map window, click Toggle Full-Screen. 

 

… and the map will now expand to cover the browser favourites, the URL, and your desktop icons. 
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2.5 Exploring the Map 

 
The best way to explore the map is to use your mouse. Click and drag the map to change your 

position and use the scroll button to zoom in and out to wherever your cursor is hovering. 

 

 

 

 

 

 

 

 

 

 

 

2.6 Zooming 

Use the zoom buttons located beneath the Base Maps Picker to zoom in and out of the map. 
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The map may also have a Zoom Slider, which you can use to quickly slide the bar up to zoom in 

to the map. 

 

 

and down to zoom out. 

 

 

 

2.7 Searching 

A number of Search options may be available in your MapThat, including external address search 

engines and search filters using your own datasets. 
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OSM (OpenStreetMap) Search 

By default, you may find that your MapThat Projects use the OSM (OpenStreetMap) Search. To 

activate the OSM Search, click on the Search Menu and choose OSM Search.  

 

 

In this example, we will choose the default Search UK Only option, which will allow you to then 

type in an address or point of interest within the UK., for example a street name. 

 

 

To activate the search, press the OK button, and the list of results will be returned. 
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Click on a result in the list and the map will then auto pan and zoom to the chosen location, 

placing a pin in the map on the selected search record. 

 

 

In this next example, we will choose the alternate Search All Data option, which will allow you 

to then type in an address or point of interest for anywhere in the world. 

 

 

…. here we will search for a city name outside of the UK e.g. Paris. 
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To activate the search, press the OK button, and the list of results will be returned. 

 

 

Click on a result in the list and the map will then auto pan and zoom to the chosen location, 

placing a pin in the map on the selected search record. 

 

However - if the chosen record falls outside of the current Projects Map Boundary, then the 

following message will appear. 
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OS Places (Ordnance Survey) Search 

Another external address search option is the OS Places search which utilises the Ordnance 

Survey OS Places API to search for UK addresses. It allows you to search by Full Address, Postcode 

or UPRN. Note - This searches the OS AddressBase dataset and not a Local Authority LLPG 

database. You will also need an API key available from the OS Data Hub. 

 

To activate the OS Places Search, click on the Search Menu and choose OS Places Search.  

 

 

There are 3 search options – Address, Postcode and UPRN. 

 

Address Search 

The Address search allows you to search for a full or partial address. For example, typing a road 

name e.g., Ringo Starr Drive will return all AddressBase records with that road name. 

 

 

To activate the search, press the OK button, and the list of results will be returned. 



 

 

Page 22 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

 

Click on a result in the list and the map will then auto pan and zoom to the chosen location. 

 

 

Postcode Search 

The Postcode search allows you to search for a full or partial address. For example, typing a road 

name e.g., Ringo Starr Drive will return all AddressBase records with that road name. 
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To activate the search, press the OK button, and the list of results will be returned. 

 

The results now show all the AddressBase records that are linked to the chosen Postcode. Click 

on a result in the list and the map will then auto pan and zoom to the chosen location. 

 

 

UPRN Search 

The third option is to search by UPRN, and this allows you to search for an address using the 

unique identifier within the AddressBase dataset. Note – this is not the UPRN value from a Local 

Authority Property Gazetteer (LLPG). 
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To activate the search, press the OK button, and the list of results will be returned. 

 

The result shows the one AddressBase record based on the UPRN chosen. Click on a result in the 

list and the map will then auto pan and zoom to the chosen location. 

 

 

 

Search Schools 

A Search can also be created for any of the Data Layers e.g. Schools.  

 



 

 

Page 25 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

Here the search could enable you to find a School by Name where the list is filtered as you type 

values. 

 

Or the Search could allow you to filter the Schools based on check box choices e.g. Status or Type. 

 

Once the search is activated the map and Data Table are filtered to show the resultant records. 
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Search Addresses 

A search could also be created to utilise your local property gazetteer e.g. LLPG.  

 

Where you can type a Full Address or postcode. 

  

Or you could use a filter box to find Addresses where their type is Residential, or Commercial 

etc... 
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Or possibly using just a Street name. 

 

 

Once the search is activated the map and Data Table are filtered to show the resultant records. 

 

 

Selecting an Address from the Data Table will then auto zoom the map to that Address record. 
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Simple Searches 

A Search in MapThat can open the Data Table and allow you to see the full record details, or it 

can be exposed as a SIMPLE Search, where the results are listed in the Search Panel below your 

search filter. For example, using the Liverpool Address Simple Search, we can search for a Street 

e.g. Ringo Starr Drive. 

 

When you press OK, the search results are now listed under the search options. 
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By Selecting a search result e.g., 4 Ringo Starr Drive, the map will then auto centre and zoom in 

to the chosen record. 

 

 

Note – Once you have ran a Search the Search Panel can be hidden back by pressing the 

ARROW/CHEVRON button on the end of the search panel. This allows you to keep the current 

search options open but minimises the panel so that you can continue to work in the map. 
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You can then press the arrow again to expand the search panel. 

 

 

 .. and run another search when you need to. 

You can also Clear the previous search parameter by clicking the clear button, and then easily 

enter the details for a new search. 
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3.0 Layers Menu 

From the Left Pane choose the first icon which will reveal the Layer Tool options. This includes 

Show, Control and Search for Data Layers. 

 

3.1 Show Layers 

The first sub menu item is the option to Show and Hide the Data Layers in MapThat. Having 

clicked on Show Layers, the menu expands to list the Layer Headers and Data layers that are 

loaded into your MapThat project. 
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Layer Headers 

Data within MapThat will be configured under a number of Layer Headers, which enable similar 

data types to be grouped together.  

 

 

Each Layer Header will contain a group of individual data layers. For example, opening the Point 

of Interest Layer Header (by pressing the + icon) in this project, we can see there are individual 

data layers e.g. Leisure Centres, One Stop Shops and Post Offices. 
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The EXPAND ALL button allows users to quickly open up all Layer Headers to see the layers below.  

 

 

Having ticked the box, each layer Header will open. 

 

Untick the box, to then Collapse and hide back all Layers Headers. 
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Data Layers 

To display a data layer simply tick the box to the left of the layer name and the map will refresh 

to show that data in the map window. For example, below we have ticked the Wards Data Layer, 

and the Ward boundaries are now shown in the map. 

 

 

MapThat allows you to display as many data layers as you wish. To display another layer, simply 

open the relevant Layer Header e.g., POI and then tick you display another layer e.g. Leisure 

Centres. 
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Thematic Layers 

If you have displayed a Thematic Layer, then the Legend for that layer can be shown underneath 

the Layer Name in the Layers list. 

 

 

Using the Show and Hide button you can choose to reveal or hide the thematic legend values. 

 

Using the tick boxes, you can also choose to display and hide specific legend categories which 

will automatically filter the items in the map window. 
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Label Layers 

MapThat also allows you to view Labels for some map layers. Depending on the setup when you 

tick to show the Label Layer it will auto show labels for each feature. For example, below the map 

is showing the Schools as Red Dots, and then the Schools Label Layer shows the School Name. 

 

Other Label Layers will ask you to choose the data to Label with. It will present a list of the data 

fields in the associated layer for you to choose from. 

 

Once you choose the Label column press OK and the Labels will appear in the map. 
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Linked Layers 

These allow you to automatically display a Child Layer when the Parent Layer is displayed. For 

example, as shown below displaying a (Child) Ward Labels layer as soon as the (Parent) Wards 

Spatial layer is shown. 

 

You can also choose not to show the Child Linked Layer as a Layer name in the Show Layers list. 
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Clustered Layers 

Where there are too many point features in your layer, MapThat also allows you to view data 

as Dynamic Clusters. Points that are close together will be clustered into a numbered circle, 

with the number defining the count of coincident points. 

 

 

If you then zoom into the map, the points will dynamically re-cluster, showing where the latest 

coincident points are. 
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Until you get to street level, where the re-clustering continues. 

 

 

Zoom Layering 

You may notice that at certain map zoom levels some datasets are greyed out within the Data 

Menu. For example, below we can see that many of the Highways and Streets layers are greyed 

out. This is because the layer/s may have too many map features to display at the current map 

level.  Hovering over these layers may also provide a tool tip stating that you will need to zoom 

in to see the features. 
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To view the features for this layer/s we will zoom into the map and at the relevant map level the 

layer’s name will become un-greyed out and you can now tick the layer to display it within the 

map. 

 

 

Layer Ellipse Options 

Next to any (or all) Layers there is an Ellipse button. 
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And dependent on the type of layer and its current state, it will have a number of sub menu 

options; including: 

• Show/Hide Layer 

• Show/Hide Data Table 

• Show/Hide Legend 

• Show Metadata 

• Export to Excel 

• Export Spatial Data 

• Zoom to Layer 

 

 

 

 

Show/Hide Layer 

This will tick to display and untick to hide the layer. 
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Show/Hide Data Table 

This will open the Data Table or close the Data Table. 

 

 

Show/Hide Legend 

This will show and hide the legend for the layer where the layer is a thematic type. 

 

 

Show Metadata 

This will show the Metadata popup for the layer. 
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Export to Excel 

This enables you to export the records from your layer into an Excel file. 

 

Export Spatial Data 

This enables you to export the records from your layer into a GIS file e.g. ESRI Shp, MapInfo Tab 

etc… 

 

Zoom to Layer 

Using this option allows you to zoom to the extents (or bounding box) of your spatial layers. 

Allowing you to quickly zoom out to see all the data very quickly. 
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3.2 Add Data 

In addition to the Layers that have already been added into the Show Layers menu, users can 

also add their own GIS data using the Add Data button. 

 

Having pressed the Add Data button the following window opens. 

 

From the left-hand side, you can select the GIS data that you wish to add e.g. Conservation 

Areas. 
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Then from the right-hand side choose how you wish to display the style for the layer, including 

options for the Stroke Thickness, Stroke Colour, Stroke Style, Fill Pattern, Fill Colour, Fill Opacity 

and an icon to use for Point data. 

 

 

Once you have made the style choices, press the Add Data button. 

 

The layer is then added into the Show Layers panel under a new Layer Header called Added Data. 
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At any time, you can remove the layer from the project by pressing the remove button. 

 

 

… as well as keep using the Add Data button to add as many GIS files as you wish. 

 

 

 

 

3.3 Control Layers Tool 

If you would like to change the style and zoom levels for any specific Data Layer, then you can 

use the Control Layers menu. 
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The Control Layers tool provides you with options for controlling the style, visibility, and order 

of your map layers. In addition, you can also use the tool to quickly zoom to the extents of any 

chosen map layer. Ensure you have loaded a Layer into the map e.g. the Ward boundaries. 

 

 

 

Now choose Control Layers and the options to control this layer’s settings are revealed. 

 

To control the style of a layer, firstly select it from the list of layers, then choose any of the four 

following tools to adjust the layers style and access copyright and metadata information. 
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Edit Style: 

 

Choose the Edit Style button and you can change the symbol for point data, the colour and width 

of lines and the fill or shape features. 

 

In this example we will use the Fill Colour and Stroke Colour/Style and Thickness to apply a new 

style to the Ward boundaries. 

 

 

To change the style and apply it your layer choose the Save & Apply button and the changes are 

applied to your layer in the map. 
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By unticking the Use Modified Style tick box you can then revert to the layers default style. 

 

Edit Visibility:  

 

 

By default, your map layers will be set to display and hide at various map zoom levels. This 

ensures that your map doesn’t become overcrowded. However, using the Control Layers edit 

visibility option you can temporarily change the zoom level at which your map layers display.  
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Edit the Zoom On value to 14, and then to apply the change, press the Save & Apply button. 

 

The Wards layer has now been removed from the map because the layer is now only visible 

between zoom levels 15 and 22. You will therefore need to zoom in to see the layer, or untick 

the Use Modified Visibility option. 

 

 

Display Order: 

If you have 2 or more layers displayed in the map you 

may find that one layer is on top and obscuring the 

features of another layer. Using the re-order arrows, you can move layers up and down, for 

example moving the Streetlights layer below the Adopted Highways will mean they are now 

below the highway’s polygons. 
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Zoom to Extents: 

 

If you have displayed a map layer that does not have any features in your current map display, 

you can zoom and pan your map to find those features. In addition, using the Zoom to Extents 

button means you can quickly zoom and pan the map to find records in any map layer. 

 

 

Save Sessions:  

 

 

 

 

Once you have made any number of style, visibility and layer order overrides you can save these 

changes to a session to be accessed at a later date.  
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Below the list of layers in the Control Layers tool will be options to Save and Load Sessions. The 

name of the current session will be shown on the left-hand side once you have opened an existing 

or saved a new session. At project startup there will be no current session. 

 

To save your temporary changes simply press the Save Session tool press Yes to agree to saving 

this session. 

 

 

 

 

and give the Session a Name and Description: 
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Once saved, you can either choose to open (apply) or remove (delete) your Saved Sessions. You 

can save up to 50 Sessions. 

 

 

 

A Saved Session will allow you to re-open MapThat and apply the following changes: 

• Load your chosen Basemap 

• Display your chosen Data Layers 

• Apply any style, zoom, and layer order overrides 

• Zoom and Re-centre the maps start-up location 

 

Layer Copyright Statement Tool 

 

 

Using the Layer Copyright Statement tool, you can view the Copyright and Licencing details for 

any layer visible within the map window. Using the hyperlink field, you can also view internal or 

external webpages for my licencing details. 
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3.4 Data Layers Search Tool:  

If there is a specific layer that you wish to display and cannot currently find it within the Show 
Layers Menu, then you can use the Search Data Layers tool. 
 

 
 
 
Simply start typing the name of your layer, e.g. Secondary Schools…. And the Data Layer Search 
tool will start to filter the list of layers based on your search. 
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Select the layer that you wish to find, e.g. Liverpool Schools, and the next window will identify 
the Projects that the chosen layer can be found within. Note that if the Search in Current Project 
Only is ticked then you can only find Data Layers in the current project. 
 

 
 
 
Having chosen the Project that you wish to find the layer within, the Location of Layer window 
will then state the full location of that layer within the Show Layers Panel. E.g. Education. 
 

 
 
 
 
Choose Display Layer to then automatically tick that layer on within the map. 
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4.0 Working with Data 

Now that we have learnt to open data layers and navigate the map, we will concentrate on 

viewing the information behind the data layers. There are two methods to view information for 

your data layers, the Data Table view and via Information Bubbles. 

Data Table 

Firstly, ensure that you display at least one data layer from within the Data Menu, for example 

One Stop Shops. 

 

You can now open up the Data Table by pressing the Reveal Arrow to the right-hand side of the 

map window.  
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If the layer(s) in the map do not have any attributes a message will inform you there is no 

attributes to show. 

 

 

The Data Table provides a list of records in rows for each of the features in the map window. You 

can scroll from left to right to view the columns of data that the Admin user has configured. If 

there are more columns/records, then a scroll bar is provided to scroll down the record list and 

across to view the additional columns of data. 

 

 

 

If you wish to find a specific record, you can use the Go To Row option to type a record number 

and press Go to jump to that record in the list. 
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The Data Table allows you to perform the following functions: 

• Reorder columns: drag a column name to the left or right and you can temporarily reorder 

the data fields. 

• Sort Ascending/Descending: Click on a column heading and you can reorder the records into 

ascending or descending order. 

• Choose columns: Click on any column header and you have the option to make the default 

columns temporarily invisible by simply unticking any column name. 

 

 

 

 

 

 

• Filter records: By typing a keyword e.g. Kirkdale, choosing which Field to filter ON and 

then pressing the filter button you can filter the records in the Data Table. To remove 

the filter, press the remove filter button.  

• Filter features in map: If you have applied a filter to your data, you can then apply that to 

the features in the map window by pressing the Apply Filter to Map button.  
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• Find record in map: Once you have found a record of interest, to find the corresponding map 

feature simply left click in the tick box next to the record and the map will automatically re-

centre over that feature and it will be highlighted in Yellow. 

 

 

 

• Choose alternate layer: If you have more than one data layer open in MapThat the Data 

Table will allow you to switch between the records by choosing from the drop-down list in 

the top right of the Data Table for example choosing to view the attributes for the Schools 

layer. 
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• Excel Exporter: A user (Role dependent) can export the records in the Data Table into 

Excel.  

• Spatial Exporter: A user (Role dependent) can export the records as a spatial file, such as a 

Shapefile, MapInfo.Tab or DXF.   

• Show All Records or only those in the current map Extent: Depending on the default settings 

for the layer you can switch between only showing the records that appear in the current 

map extent or switch to list all the records in the underlying table.  

• Edit Attributes: A user (Role dependent) can use the Edit Attributes tool to make 

changes to the values in the Data Table and then use the Save option to save those 

changes.  

• Remove Layer: Pressing the red X will remove the current layer from the map window and 

untick it from the Show Layers list.  

 

 

SQL Builder  

In addition to the simple Filter option, the Data Table (Role and Layer dependent) 

provides a SQL Builder tool.  

 

Having chosen the SQL Builder button a SQL Query window opens. 
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Use the Columns, Operators and Unique Values drop down lists to build you query. For example, 

filtering the Planning Applications to find those where the Proposal includes the word 

‘Bedroom’. 

 

Column – Proposal  

 

 

 

Operator – Like 

 

 

 

 



 

 

Page 62 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

Value – ‘%Bedroom%’ 

 

 

 

Press the TEST button to check if the query is valid. 
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And then to run the query press Apply. 

 

The Data Table and map will now update to only show the records that meet the SQL qury. 

 

 

 

Information Bubbles 

In addition to the Data Table, users can view information about data layers using an Information 

Bubble. Simply display a layer e.g. Schools or Leisure Centres and then left click on any map 

feature to show the Information Bubble. Information Bubbles can be moved around the map by 

simply clicking and dragging. 

 

 

The Information Bubble can either work when you click on a feature or when you hover over a 

map feature. This is controlled using the Toggle Bubble button found in the Map Preferences 

tool.  
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If you have multiple Data Layers visible in the map window, the Information Bubble will allow 

you to click once in the map and an Overview Information Bubble will appear which will list each 

of the Data Layers at that location and provide a count of the records in each layer, shown in 

brackets: 

 

By clicking the plus button, you open the list of records for that Data Layer e.g. the Wards or 

Schools. Now in the Overview Bubble you can see the name of that record. 

 

 

Then by simply clicking on the name you open up the individual Information Bubble to see the 

other attributes and the map feature will also be highlighted in yellow. 
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At the bottom of the Information bubble will still be listed the number of map features at the 

chosen location and at the top of the bubble will be the name of the Data Layer currently being 

displayed in the bubble. By clicking the right arrow, you can then switch between the Information 

Bubbles for each feature. 

 

 

At any time, you can return to the Information Bubble Overview by clicking the Show All button. 
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5.0 Main Toolbar Tools 

 

 

At the top of MapThat there is the Main Toolbar which provides access to the most commonly 

used tools. 

 

Go Home Tool 

 

Use the Go home tool located on the Main Toolbar above the map, and your map will re-centre 

itself at the chosen start position, e.g. the UK or your local authority boundary. 

 

Map Links – Google StreetView and Earth 

 

Click the person icon to activate Google StreetView or the globe icon to activate Google Earth 

and then click anywhere in the map to activate the link. A new window will open showing that 

location in either Google StreetView or Google Earth.  

 

Clear All Map Tool  

  

Using the Clear All Map tool will clear any layers and/or information bubbles that have been 

turned on. 
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Help Tool  

 

The Help tool provides a link to online help material, such 

as online user guides and help videos. To close the Help 

window simply click the X in the top right corner. 

 

 

 

 

 

There is also tool specific help options for each menu and tool in MapThat. For example, clicking 

the Help icon on the Area Search Tool banner will open a floating help window which could have 

a help page or help video. 

 

 

 



 

 

Page 68 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

Show My Location Tool  

 

Pressing the Show My Location tool will recentre the map over your current geographic location, 

placing a blue pin in the map centre. This is a great tool when using MapThat in the field. 

 

 

Refresh Map Tool  

 

If you do not have auto refresh switched on, then the Refresh Map tool will refresh the map for 

you. When a layer is turned on in MapThat it will only bring in the data that can be seen within 

the window (making it much quicker). If you navigate away from your location, then you need to 

choose refresh to bring in the data for that new geographic area. 

 

Export Map to PNG Tool  

 

MapThat has a number of printing tools for creating scale print templates. But if you want to 

print a very quick map, choose the Export Map to PNG button. This will then export the current 

map, including all displayed layers, to a PNG file in your downloads folder. 
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Logout Button 

 

If you need to logout of MapThat you can use the Logout button which is located on the right-

hand side of the main tool bar. 
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6.0 Map Tools 

 

 

On the lefthand pane the second icon will reveal the Map Tools. 

 

The Menu on the left pane will now update to show all Tools and Menus available for controlling 

the map. 
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6.1 Map Preferences 

The Map Preferences menu provides a collection of useful tools and settings to control how the 

mapping interface works for you. 

 

 

Auto Refresh Tool  

 

 

 

 

 

By default, the Auto refresh tool may either be on or off, so by switching to another option you 

can choose if the map layers automatically refresh as you move around the map or manually 

refresh using the refresh tool on the main toolbar.  

This will ensure that you always see map features in your map window, but this may slow down 

your mapping experience. 
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Hover Bubble 

 

 

The Information Bubble can either work when you click on a feature or when you hover over a 

map feature. This is controlled using the Toggle Bubble button found in the Map Preferences 

tool.  

 

View/Hide Map Overview 

 

 

This setting controls whether the Map Overview window is shown or hidden in the map window.  

 

Change Project Tool  

 

 

The Change Project tool is in the Map Tools > Map Preferences menu. This allows you to change 

the project depending on the type of data you wish to see and functions you need access to. 

Many users will only have one project and this tool may therefore be invisible. When changing 

projects, you have 3 options; you can choose to Keep the Current Map Location, Keep the Current 

Map Location & Layers and also choose to use the new Projects default settings. 
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The Change Project Tool can also be activated using the Change Project button from the main 

toolbar. 

 

 

And can also be revealed and hidden from the top of the map window. 

 

Hover over any of the Project Boxes to see the name of that Project. 

 

Then simply click inside one of the Project Boxes to switch to that Project. 
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Cache Tool 

 

 

The Cache tool allows you to control how Cached layers are shown within the map window – for 

example the Lower Super Output Areas (LSOA’s). 

 

A Cached layer will generally be a polygon (spatial) layer that is being displayed in the map as 

historically cached image (.png) files. This means that their display is very fast. However, over 

time as the underlying geography may change, those cached images will need to be updated. 

Using the Cache tool, you can control whether you use the Cached tiles which have already been 

created for that location (Cache On/ticked), or whether you start to re-generate new cached tiles 

as you move around the map (Cache Off/unticked). 

 

The Update Cache Tiles button will ignore the setting chose for Cache On and will instead always 

create new tiles for any area that you navigate to. This will mean the map will take longer to 

render, but you know that the shape being shown is always correct. 
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View/Hide Admin Message 

 

 

 

 

The View or Hide Admin message allows the user to hide any Administrator messages that appear 

across the MapThat map. 

 

 

Map Opacity 

 

 

The Map Opacity Slider allows a user to change the opacity of the basemapping e.g. Aerial 

Imagery in order to see spatial map features more clearly. 
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6.2 Measure Tools 

The Measure Tools are provided under the Map > Measure Tools menu. 

 

 

 

 

 

 

The MapThat Measuring tool gives options to measure distances, areas and to change the units 

between Kilometres, Metres, Miles, Hectares and Acres. This tool allows the user to manually 

measure the distance between points in the map by clicking the cursor in the map, while using 

the backdrop mapping as a guide to measure existing road lengths or distance between 

geographic features. It also has options for snapping to map features e.g. OS Mastermap, and 

the ability to auto calculate the measurements for existing objects. 
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Place Multipoint Line:  

 

Click anywhere on the map to create a line. Double click on the mouse to finish the line. The 

resulting length will be displayed in the selected units. 

 

 

 

 

 

 

 

 

 

 

Place Shape: 

 

Click in the map to create a shape and calculate the area and perimeter values. 
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Existing Shape: 

 

Click on a shape on the map (polygon or line) and the area and perimeter for polygons and the 

polyline length for lines will be calculated. The default option is to measure the area of Individual 

features, which means if you select another feature the area is recalculated for that individual 

feature. 

 

 

Changing the option to All Objects then allows you to select more than one shape at the same 

time, and the Measuring tool will calculate their cumulative area. 

 

 

If require you can change the distance units used to be Metres, Miles, Hectares, Acres and 

Kilometres. 
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Finally, for accuracy you can tick the Enable Snapping option to snap to existing features e.g. OS 

Mastermap so that as you draw the measure line you can snap to roads and buildings etc… 
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6.3 Area Search 

The Area Search Tools are provided under the Map > Area Search menu. 

  

 

The Area Search tool gives the user options for geographically 

analysing features within the map window. Option include 

being able to identify features that fall within existing features, 

or within a distance of a point, line, or shape that you draw 

within the map. The tool allows you specify the buffer distances 

using either using kilometres, miles, or metres.   
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Place Point: 

 

Choose the Place Point option and then left click in the map to choose an origin location and 

then define the distance e.g. 1000 metres for a buffer from that point.  

 

 

Pressing the Confirm Area button will then draw a buffer is then drawn in the map at 

1000m radius from the chosen location.  

 

 

By then choosing the Apply Search Area button, you can choose to apply the buffer 

object to any layer within MapThat, e.g. to find the Schools within the 1000m buffer. 
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The Apply button will provide you with options to export one layer, a list of layers, all layers and 

also options for exporting the results directly to an Excel document. 

 

 

Once applied the Schools in the map will then be filtered to only show those within the buffer 

area. 

 

 

Create Point using X&Y  

 

 

Using a pair (or many sets of) known coordinate/, either using Easting/Northing or X&Y, you can 

also generate buffers around a point in the map. 
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You can add one pair of coorcinates 

 

Or a set of coordinates to create multiple buffers. 

 

If creating multiple buffers, you can choose to either have individual or merged buffer objects. 
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Address: 

 

As well as simply clicking in the map to define an origin you can also type an address to start the 

search from that location. Once the buffer has been confirmed and applied you can select 

features falling inside the buffer object. 

 

Create Multipoint Line:  

 

Click anywhere on the map to create a line. Double click on the mouse to finish the line. The 

resulting length will be displayed in the selected units. Once the buffer has been confirmed and 

applied you can select features falling inside the buffer object. 
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Create Shape: 

 

In addition, you can simply draw a shape in the map window by left clicking to define the 

boundary and double clicking to end the shape.  

 

 

Create multiple Areas: 

Instead of just creating one Area Search, you have the option to create multiple search areas. For 

example, you can create a point buffer, multipoint line buffer and also create your own shape. 
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Existing Shape: 

 

By using an existing shape, it is possible to select features from a Data Layer that fall 

within/intersect the boundary of another layer. For example, you can select the School features 

that are within a specific Ward boundary. 

By choosing to display the multiple Data Layers e.g. – Schools, One Stop Shops and Conservation 

Areas you can also filter features from multiple map layers. 

 

Using the Area Search tool, choose Use Existing Shape and from the map window select one of 

the Ward boundaries. 
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Finally choose Confirm Area and then Done to apply the Search Area. Then apply the Search Area 

to the Schools, One Stop Shops and Conservation Areas, by selecting them manually or clicking 

Select All Layers. 

 

 

The features in the map and the Data Table will now be filtered to only show those that fall within 

the chosen Ward boundary. 

 

 

Clear Search Area: 

The Area Search Tool allows you to create multiple Search Areas at one time. If, however, you 

have created a Search Area that you wish to remove, then you can choose the Clear Area button. 

For example, below we have created 3 Search Areas – a simply point buffer, a line buffer and an 

irregular shape buffer. 
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To remove a Search Area, choose Clear Area. 

 

 

You now have the choice to either Clear the Last Search Area or to Clear All Search Areas. We will 

choose to Clear the Last Search Area. Now notice how the 3rd Search Area has been removed 

from the map. 
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6.4 Map Location 

The Map Location Tools are provided under the Map > Location menu. 

 

 

The Map Location menu provides three options, Map Coordinates, Identify Coordinates and the 

Identify Address Tool. 
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Map Coordinates: 

 

 

The Map Coordinates tool shows the user the coordinates of the current cursor location. The tool 

will display the coordinates in both Easting and Northing and Longitude and Latitude. 

 

 

Identify Coordinates: 

The Identify Coordinates tool allows the user to click in the map window to identify the 

coordinates of a chosen location. 

 

• Click in the map: click anywhere in the map window and the coordinates will be shown either 

in Long/Lat or OS Easting/Northing. 
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In addition to Long & Lat and Easting & Northing, you can choose the what3words option and 

when you click in the map it will return the 3 words for that w3w location. 

 

 

 

•  Find a location: type a new set of coordinates and by pressing Go (Arrow), the map will 

automatically pan to the chosen coordinates. 

 

 

 

You can also type a w3w location and pressing the Go Arrow will re-centre the map over that 

w3w location. 
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Identify Address: 

The Identify Address Tool will show the google address for the location as you click in the map. 

This tool is very useful if you don’t have a Local Land and Property Gazetteer. 

 

 

If revealed in the Map location tool, you can also identify the w3w location for any location in 

the map. 
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6.5 Bookmark Tools 

The Bookmark tool is provdied under the Map > Bookmarks menu. 

 

 

The Bookmark tool allows you to zoom the map to any location by choosing from a list of saved 

bookmarks.  
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To open the bookmark, simply choose from the dropdown list and press the Open Bookmark 

button. The map will then recentre over that saved location. 

 

 

 

 

 

 

 

 

 

The map now recentres over the chosen bookmark. 
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To create a new bookmark, simply re-centre the map over your chosen location and 

press Add Bookmark, then type a name for the new bookmark. 

 

 

 

Then press the Save Bookmark button and the new Bookmark will be added to the 

list of available options. 

 

 

 

To delete a bookmark, simply press Delete. 
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You will be asked to confirm if you wish to delete the chosen bookmark. If you choose OK, then 

the bookmark will be deleted. 

 

 

Finally, you can also have the option of copying the map to clipboard which you can then email 

to colleagues in order to share your chosen maps. 
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6.6 RouteFinder Tool 

The RouteFinder Tool is provided under the Map > RouteFinder menu. 

 

 

 

 

 

 

 

 

 

 

 

The tool allows a user to; 

• Define Route: The RouteFinder tool allows you to 

define a series of Waypoints (stop locations) by 

clicking in the map window. The Way points can 

be edited (moved) once added so that you can 

change the route to be calculated.  

• Route Mode: The tool allows you to generate 

routes using either driving mode or walking mode. 

• Route Type: Finally, you can decide to generate 

the quickest (time based) or shortest (distance 

based) route.  

• Calculate Route: Once you have defined the 

waypoints, the route mode and then route type 

press Calculate route and RouteFinder will 

generate the optimum route as well as create 

directions for travel. 
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If you need to move a Waypoint, click the Edit Route option, and drag a Waypoint to a new 

location. 

 

 

 

 

 

 

Then simply press the Calculate Route button again to recreate the new route.  
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6.7 Find My Nearest Tool 

The Find My Nearest Tool is provided under the Map > Find My Nearest menu. 

 

The tool allows a user to choose; 

• Start point: The Find my Nearest tool allows you 

to identify the nearest map features from any 

given location. The start location can either be 

defined by clicking in the map or typing an 

address. 

• Choose Layer: From the drop-down list choose 

the layer from which you wish to identify results 

e.g. Schools. 

• No of records: Specify how many Schools to find.  

• Max Distance: Define a cut off distance after 

which the tool will no longer search for features. 

• Distance Units: Specify the max distance value to 

be in Metres, Miles, or Kilometres. 

• Go: To run the Find my Nearest tool simply press 

Go.  The tool will then use the underlying road 

network to identify the 5 nearest schools from 

the starting location using the parameters 

specified.  
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The Data Table will also update to now only list the X number of records that are nearest to the 

chosen start location, with a distance column added to each record. 

 

Using the Info Bubble tool you can also identify a FMN point within the map window. 
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6.8 Travel Time Tool 

The Travel Time Tool is provided under the Map > Travel Time menu. 

 

The tool allows a user to choose; 

• Start point: Can be defined by clicking in the map 

or typing an address. 

• Measure Unit: The catchment area can be 

calculated using either Km or Miles p/hour speeds. 

• Speed: Having defined the time units, now specify 

the speed at which you will likely travel e.g. 10 Km 

per hour.  

• Hours: Finally define the time in hours that you will 

be traveling e.g. 0.5. 

• Press the Calculate route simply button and the 

Travel Time Distance tool will then use the 

underlying road network to calculate how far you 

will travel given the parameters specified. The 

resultant catchment area can then be displayed in 

the map and used for spatial analysis e.g. how 

many schools are within a 30-min drive at 10km 

per hour.  
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Travel Time zones can be used to filter map objects e.g. which are the Post Offices within a 30-

minute 10 Km/ph. distance? 
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6.9 Social Media Tool 

The Social Media tool is available within the Map > Social Media Tools menu. 

 

 

The Social Media Tool allows you to copy your Map Location as a bookmark and share that with 

other users via your choice of Social Media, including; Twitter, Facebook, LinkedIn etc. 

Having chosen your map location and displayed the layers that you wish to publish, in this case 

the Planning Applications layer: 

 

Now choose the Social Media tool and select your choice of platform. In this example we will 

publish the map to twitter by pressing the Share Arrow. 
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The URL (a shortened version) for your current map location will then be passed to Twitter, where 

you can choose to Share the link. 
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6.10 MyCommunity Tool 

The MyCommunity tool is available within the Map > MYCOMMUNITY Tools menu. 

 

 

MyCommunity Tool allows you to instantly understand information about your local area, 

including which Ward, Postcode, County you live in, whether there are any environmental 

constraints near you, and what are your nearest points of interest, e.g. Schools, Hospitals etc. 

 

The top part of the MyCommunity Tool allows you to specify and change your location, either by 

typing a postcode, clicking in the map, or panning the map and choosing Update Your Location. 

 

 

 

Having chosen your location, the Main Summary Section of the MyCommunity Tool shows you 

the standard information e.g. Wards Names, Bin Collection Dates and Deprivation data. 
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Scrolling through the SUMMARY Tabs allows you to understand if there are any Environmental 

Constraints affecting your chosen location. For example, are you within an Open Space, Park, or 

Conservation area? 

 

 

 

A green tick denotes that you are within the constraint, and a red cross denotes you are not. By 

clicking the Map icon for a layer, you can choose to display that layer ion the map. 
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Other Tabs can be configured to calculate how many point, line or polygon map features are 

within a set distance of your location. For example, how many Conservation Areas are within 

2Km? 

 

 

The Data Tables below the main section then reveals your Nearest Information, for example the 

nearest 7 Secondary Schools: 

 

 

The attributes for these nearest features can either be returned using the Info Bubbles or by 

opening the Data Table, where the records are filtered to show the nearest 7 Schools with an 

added distance column. 
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The Data Tables can be revealed and also hidden back using the Arrow icons to the left of the 

Data Table name. 

 

Finally, if a web link has been included, you can simply click on the link to open the web page 

linked to the chosen record. 
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The MyCommunity Results can also be shown in a Popout Window, so the results are easier to 

see. To do this, simply click the Popout Button within the left panel. 

 

All of the Location, Summary, Constraint and Find My Nearest Results are then shown in a Popout 

dashboard allowing you to interrogate the results more easily. 

 

 

Clicking the Download PDF icon then allows you to view the results in a PDF Report.  
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6.11 Map Links 

The Map Links Tool is provided under the Map > Map Links menu. 

 

 

The Map Links tool is split in three parts – Google StreetView, Google Earth and Side By Side 

Mapping. 

 

The Google StreetView tool allows a user to choose;  

 

• Rotation: A value between 0-360 determines 

the rotation of the camera within Google 

StreetView. 

• Pitch: A choice of horizontal and down arrows 

will determine the camera pitch within Google 

StreetView. 
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Having specified the Camera Rotation and Pitch, choose the PIN MARKER icon and click in the 

MapThat Map window. A new web page will open which will open Google StreetView and centre 

the map over the chosen location, using the Rotation and Pitch specified. 

 

 

 

The Side By Side tool allows a user to choose; 

 

• Zoom Level: A value between 12-19 

determines the map zoom level displayed in 

Side by Side Mapping, 

• Historic Layer: A list of available Historic 

Mapping Layers e.g. OS 1885-1900. 

• Basemap Layer: A list of available Base 

Mapping Layers e.g. Bing Satellite. 

 

Having specified the Map Zoom Level, the Historic Map Layer and the Basemap, choose the PIN 

MARKER icon and click in the MapThat Map window. A new web page will open which will open 

the Side by Side map interface and centre the map over the chosen location, using the zoom level 

and mapping layers chosen in the Map Links configuration. 
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The Google Earth tool allows a user to choose;  

• Altitude and Distance to Target: A value of 100-500 

defines the Altitude and Distance of the Camera to 

the chosen Target object. 

• Tilt Angle: A value of 0, 45 or 90-degrees Tilt of the 

camera within Google Earth. 

• Static or Rotated: A choice of either a Static Image 

or Rotating 3D View within Google Earth. 

 

Having specified the options choose the PIN MARKER icon and click in the MapThat Map window. 

A new web page will open which will open Google Earth and centre the map over your location. 
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6.12 Temporal Slider 

The Temporal Slider Tool is provided under the Map > Temporal Slider menu. 

 

 

The Temporal Slider tool is split in three parts – Layer, Filter, and Type. 

 

Choose Layer -  

From the Choose Layer list box, select the layer that you wish to filter. These can be layers such 

as Incident points e.g., crimes, faults etc… 
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Filter On -  

Having chosen the Layer to filter, if that layer has an option to Filter On, then you can choose 

that in the next list box. For example, for the ADC – Incidents layer we can filer on the Incident 

Type field, and choose a type e.g., Fly-Tipping. 

 

 

Choose Temporal Type -  

Having chosen the Layer and Filter on option, you can now choose how to filter the incidents, 

e.g., by Day of Week, Month or Year, or by Year. Simply, choose the radio button to make your 

choice. 

 

 



 

 

Page 115 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

Move Slider -  

Using the Slider Bar, you can choose the Day of Week, Month of Year, or Year – dependent on 

the Temporal Type chosen. 

 

Finally tick the Apply button to apply the Temporal Filter to the layer. 

 

The map will update to show the Fly – Tipping Incidents on Thursday’s. 

 

 

The results of the Temporal Slider tool can also be filtered geographically, using the Area Search 

tool. To enable a geographic filter, tick the Filter with Area Search option. 
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This will open the Area Search tool on the left-hand side. In this example we will click in the map 

to place a point and then create a 1 km buffer from that location. 

 

 

Having applied the Area Search a 1km buffer appears and the filtered records are updated to 

only show those within 1km of the chosen location. 

 

 

 

At any time, you can untick the Filter with Area Search option, to then remove the geographic 

query and show the originally filtered records again. 
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6.13 Document Viewer 

The Document Viewer Tool is provided under the Map Tools> Document Viewer menu. 

 

 

The Document Viewer tool allows you to view any images or documents that have been 

uploaded against any map feature. For example Site photographs, HMLR Titles, Planning 

Applications etc… 

 

Having chosen the Document Viewer Tool the panel opens as below. 

 

 

 

Firstly, click in the drop down menu to Select the Layer that you wish to view documets for. 
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Note – you can only view documents/images for layers that have already been made visible in 

the map. 

 

In this example we have already added the Liverpool Planning Apps Layer, so we will choose that 

layer from the list box. 

 

 

Having selected the layer, the Document icon will become active so click on the button and a red 

line will be placed around the icon. This means the tool is now active so when we next click in 

the map the Document Viewer tool will be used. 

 

 

 

If you now click in the map on a Planning App feature the Document Viewer tool wil open. If that 

map feature doesn’t have any documents or images uploaded then the Document Viewer will be 

empty. 
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However, if we choose a map feature that has an image or document uploaded the Document 

Viewer will show a preview of that document. 

 

Note – the document title is shown at the top of the preview – shown in the grey banner. 

 

If there are multiple documents attached to the map feature, use the Next and Previous buttons 

to browse through the documents to preview each one. 
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If the map feature has a Document attached to it, the preview will show a sample PDF image. 

 

 

Any document or image can then be downloaded or previewed in anther window, by choosing 

the Download File Arrow. 
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For example, if we download a document, it will be downloaded to your documents folder for 

you to then open and view. 

 

 

If we download an image e.g. a site photo, the image is downloaded and will also be auto open 

into a new window to view. 
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6.14 Shared View Tool 

The Shared View Tool is provided under the Map Tools > Shared View menu. 

 

 

The Shared View tool allows you to view any 2 Basemaps side by side, so that you can compare 

land use change or an aerial image against vector maping. 

 

Having chosen the Shared View Tool the panel opens as below.  
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The Shared View tool allows the user to choose the 2 basemaps that you wish to view and also 

the size of the window. 

 

Having made the selections choose the Apply button to open the Shared View Tool. 
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The Shared View tool opens and shows the two chosen basemaps side by side. You can then pan 

and zoom in either basemap window and the alternate window also updates. This then allows 

you to compare the two basemaps. 

 

 

You can resize the Shared View tool by dragging the edges of the window to make the window 

bigger. 

 

 

… and if available you can also choose to view current mapping against historic mapping layers 

to see how land use has changed over time. 
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6.15 Layer Spy Tool 

The Layer Spy Tool is provided under the Map Tools > Layer Spy menu. 

 

 

The Layer Spy tool allows you to see through the existing basemap to see an alternate basemap 

below. 
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Having chosen the Layer Spy Tool the panel opens as below.  

 

The Layer Spy tool allows the user to choose 1 basemap that you wish to view below the existing 

basemap, for example Google Hybrid. 

 

 

You can also choose the size of the Layer Spy window for example setting the width to be 200. 
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Having made the selections choose the Apply button to open the Layer Spy Tool. 

 

 

 

… and as you pan the mouse, the Layer Spy window allows you to view the alternate basemap. 

 

You can change the basemap and Spy Glass width as needed… for example viewing historic 

mapping below a current basemap. 
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7.0 Excel Loader Tool  

The Excel Loader Tool is provdied as a sub menu under the Edit Tools > Import Data menu. 

 

 

Having clicked Import Data the following 2 options are revealed. 

 

The Excel Loader tool allows you to load (or display) an excel file with records that have either 

coordinates or a postcode, into your map window. 
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Show Excel Layer 

To show an Excel Layer that has previously been imported, simply tick the box to the left of the 

layer and the points will be added into the map window. 

 

 

By selecting multiple layers in the list, you can show multiple Excel Layers in the map e.g. Crimes, 

Hospitals and Parks. 

 

 

By toggling the Clustering option before you load a layer, means that when the layer 

is added if there are multiple points close to each other these will be clustered.  
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Export Excel Layer 

 

Choose an Excel Layer that has previously been loaded from the Import Layer list e.g. the 

Liverpool Parks and then press Export Layer. The data is then saved into Excel format. 
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Delete Excel Layer 

 

 

Choose an Excel Layer that has previously been loaded from the Import Layer list and then press 

Delete Layer. That Excel Layer will then be deleted from MapThat. 

in the map at that location. 

 

New Excel Layer 

 

 

If you have an excel file that you wish to upload, choose the Create New Excel Layer button. 

 

 

• Name: Specify the name of the Data Layer 

that you will create. 

• File: Browse to find the excel file on your PC 

and choose open. 

• Icon: Choose an icon style to represent the 

point’s e.g. a Hospital symbol.  

 

 

 

 

If you require Help on how to upload an excel file and what the pre-requisites are then hover 

over the Help button and an information window will appear. 
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Note – MapThat will geocode records using either an X&Y coordinate, Full Address, Postcode or 

what3words address. 

 

 

Choose the upload button and the records in your excel file will be geocoded. 

 

And added into the map window. 
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8.0 Spatial Importer Tool  

The Spatial Loader Tool is provdied as a sub menu under the Edit Tools > Import Data menu. 

 

 

The Spatial Importer tool allows you to load a GIS or DXF dataset of points, lines, or polygon 

features as a layer into your map window. 

 

 

Show Spatial Layer 

 

 

Choose a Spatial Layer that has previously been loaded from the Import Layer list and then press 

Show Layer. The spatial layer will be added into the map window. 
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Where you can use the information bubble to examine the features attribute information. 

 

 

Export Spatial Layer 

 

 

Choose a Spatial Layer that has previously been loaded from the Import Layer list and then press 

Export Layer. The layer can then be exported to MapInfo.Tab, ESRI.Shp or AutoCAD.Dxf. 
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The spatial layer will be exported, and a Zip file saved on your PC. 

 

 

Delete Spatial Layer 

 

Choose a Spatial Layer that has previously been loaded from the Import Layer list and then press 

Delete Layer. That Spatial Layer will then be deleted from MapThat. 

 

New Spatial Layer 

 

If you have a spatial file that you wish to upload, choose the Create New Spatial Layer button. 
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• Name: Specify the name of the Spatial Layer that 

you will create. 

• Open Browse to find the GIS file on your PC and 

choose open. 

• File: Specify if you are uploading a TAB, SHP or DXF 

file. 

• CRS: Choose the projection of the Source data. 

• DB: Choose the Database that the spatial data will 

be uploaded too.  

 

 

 

 

If you require Help on how to upload a spatial layer file and what the pre-requisites are then 

hover over the Help button and an information window will appear. 

 

 

 

Choose the upload button and the spatial layer will be imported into MapThat.  
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9.0 Sketch Tools 

 
The Sketch and Drawing Tools are provdied as a sub menu under the Edit Tools > menu. 

 

 

The Sketch Tools allow you to perform Red Lining on temporary layers, while the Drawing Tools 

will edit and create features into existing MapThat Layers. The tools available are the same for 

both tools (although the Sketch Tools have a Draw Text and Draw Arrow tool), and we will 

explore these later in this section, however firstly we will explore how to work with Sketch Layers. 

 

 

 

Show Sketch Layer 
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Choose a Sketch Layer that has previously been created from the Sketch Layer list and then press 

Show Layer.  

 

 

The layer is then opened into the map window where you can now view the features already 

drawn into that Sketch Layer. 

 

Delete Sketch Layer 

 

 

Choose a Sketch Layer that has previously been created from the Sketch Layer list and then press 

Delete Layer. That Sketch Layer will then be deleted from MapThat. 
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Add Sketch Layer 

 

 

If you wish to create a new Sketch Layer for your own Red Lining, then choose the Add Sketch 

Layer tool, give the new Sketch Layer a Name, and press OK. 

 

 

The suite of Sketch Tools will then open. 

 

 

 

 

 

 

 

 



 

 

Page 142 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

Edit Sketch Layer 

 

 

If you already have a Sketch Layer that you wish to Edit, simply choose the Sketch Layer Name, 

and press the Edit Pencil icon. 

 

 

The Sketch Layer will be added to the map and the suite of Sketch Tools will open. 
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The suite of Sketch Tools is also shared with the Drawing Tools, and we will explore the drawing 

(create) tools in the next section.  

 

However, there are three tools that are unique to the Sketch Tools, and not included in the 

Drawing Tools, including: 

 

Draw Text 

The Sketch tools allow you to annotate your map with text. To do this choose the Draw Text 

button. 

 

 

Enter the text annotation… 

 

 

.. press OK and left click in the map to position to the text annotation. 
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Draw Arrow 

The Draw Arrow tool allow you to create arrow markers in the map To do this choose the Draw 

Arrow button. 

 

 

 

Left click in the map to start the arrow, then double left click to finish the arrowhead. 

 

 

 

Style Features 

This provides the option to edit the style of features that you draw in the map. 

 

 

Choosing the Show Style Features opens the extra style panel, which gives you options to: 
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• Thickness: A numeric value to define thickness of lines. 

• Stroke Colour: Choose the colour for the stroke line of lines and polygons 

• Fill Colour: Choose the colour for the fill of polygons. 

• No Fill: Allows you to make the polygon have no fill. 

• Pin Icon: Choose an icon for point data. 

• Opacity: Define how opaque the feature is.  

• Text Size: Choose a numeric value for the size of text labels. 

• Stroke Style: Choose the style for lines e.g. Dotted, Plain, Dashed.  

• Text Font: Choose a font style for text labels.  
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Having chosen a style, the next time you draw a new object the feature will use the new styles 

options. 

Using the Apply Style Feature tool allows you to choose a new style and then apply that style to 

an existing map feature to update its style. For example, changing the polygon to a green fill and 

dotted line. 
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10.0 Drawing Tools 

 
The Drawing Tools are provdied as a sub menu under the Edit Tools > menu. 

 

 

 

 

 

 

 

 

Note – if a layer is shown greyed out, this is because the layer cannot be displayed at the current 

zoom level, so either zoom into or out from the map as needed. 

 

Edit Layer 

From the Edit Layer list, choose any existing MapThat layer which your login credentials allow 

you to edit, and then press the OK button. The layer will be added into the map window and the 

Drawing Tools will also open. 

 

 



 

 

Page 148 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

Create Tools 

The Drawing Tools are located in the Create panel, and include options for creating points, lines, 

polygons, and circles. 

 

 

Place Point 

 

 

You can either click anywhere on the map to interactively place the new Point, type an X and Y 

location to place the point icon at a specific location, or choose to place the new Point at your 

current geo-location. 

 

 

Draw Line  
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Click on the map to draw a multipoint line. Left clicking to change direction and double clicking 

to complete the line. 

 

Draw Polygon 

 

Click in the map and to add multiple points in order to create a polygon shape. 

 

Draw Rectangle  

Use the Define Width/Height and click on Map tool to create a rectangle. 

 

 

Defining a width and height value in metres for the feature. 

 

 

Draw Circle 

Click anywhere on the map to place the point and drag open a Circle.  
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Or click in the map and define a radius for the Circle. 

 

e.g., specify a radial distance for the circle. 

 

Or define the radius and also type an X and Y location to place the point icon at a specific location. 

 



 

 

Page 151 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

 

 

As you draw a new feature in the map, the Distance and Area values will auto update as you left 

click to change shape. This allows you to create features based on defined distances and 

dimensions.  

 

 

 

 

Edit Layer Opacity 

If there are multiple objects already in your editable layer, you can use the Opacity Slider to make 

the editable layer opaque so that you can more easily digitise your new record. 
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Other Map Layer Opacity 

If there are other map layers on and they are impairing your ability to add your new feature, you 

can use the Opacity of Other Layers slider to change the opacity of those layers, to thin them, so 

you can see more easily. 

 

For example, changing the slider to 20% will make those layers more translucent so it’s easier to 

see! 
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Snapping 

Ticking the snapping option allows you to choose a layer to snap against e.g., OS MasterMap. The 

next time that you use a drawing tool the cursor will snap to the snapping layer allowing you to 

draw new features more accurately. 

 

 

Tracing 

Ticking the tracing option allows you to choose a layer to snap against e.g., OS MasterMap. The 

next time that you use a drawing tool the cursor will trace around the snapping layer allowing 

you to draw new features more accurately. 
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Edit Tools 

 
 

The Edit Tools then allow you to edit those features, by moving them, deleting them, reshaping 

them, editing their attributes, and also adding Holes. 

 

Cancel Operations  

 

Stops any current drawing tools and returns to your cursor. 

 

Move shape  

 

Hover over an existing point, line or shape and your cursor will change to a hand, which you can 

then use to drag the object to a new location. 

 

Edit Shape 

 

Allows you to edit the geometric shape of line and polygon features. Simply select the map 

feature by clicking on/within it and then left click on any existing line or bounding line of a 
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polygon and you can either move an existing vertex or add a new vertex and move that to reshape 

your map features.  

 

 

Again, using the Reshape tool by single left clicking on any existing node/vertex…. 

 

 

 

 

 

 

 

 

… you can delete that node/vertex to further reshape your feature. 
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Remove Shape  

 

Click the Remove button and then select an existing polygon, point or line to remove the shape 

from the map. Choose ok (or cancel if you change our mind).  

 

 

The record will be deleted successfully. 

 

Note - this is permanent, you do not need to save after making this amendment. 

 

 

Edit Attributes  

 

Select a feature you wish to edit the details for e.g. a planning application and an Edit Attributes 

box will appear. Depending on the configuration of the box you will either be able to choose a 

value from a drop-down list, date/time window or you can type free text.   
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Note - that some fields may be mandatory, and these are marked with a red asterisk. 

 

Add Holes  

 

You can add a Hole to a current map object by simply digitising the new shape around the area 

to be removed. This can be very useful for grounds maintenance i.e. clipping out Rose Beds, 

building features from the centre of grassed areas. 

Simply draw the outline for the complete polygon feature. 

 

Making the Drawing layer Opaque we can see that there is an area of Water within the grassed 

area. 
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Before you add the hole, choose a Snapping Layer so that you can accurately trace around the 

Water to draw the hole. Then from the Edit sub menu choose the Add Ring tool and digitise using 

the Snap to create the Hole in the grassed area. 

 

 

Once you compete the Add Ring the area is then cut out from the existing polygon and auto 

saved. 
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Undo Tool 

 

The undo button will enable you to undo the last action, including the last; Reshape, Move, 

Delete and Add Ring action. 

 

Delete Multiple Features Tool 

 

If you need to delete multiple records/features in the map, simply choose the Delete Multiple 

Features tool, select the features (they will turn red), and then choose the Remove tool. 

 



 

 

Page 160 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

Marque Selection Tool: 

 

In addition to the Delete Multiple Features tool, we also have the ability to drag a box over your 

map features to marque select them for deletion. From the Drawing tools choose the Marque 

Selection tool, left click in the map and with the control key held down you can draw a box shape 

in the map.  

 

 

 

Each map feature that falls within the box is then selected. 
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… then choose the Remove button and the features will be removed. 

 

 

 

 

Save Changes 

 

 

Once you have made any changes e.g. added new features or added/updated attributes, press 

the Save icon and the data will be saved into the underlying spatial table. If you have edited a 

layer that has a Theme associated to it, e.g. the planning applications, then the map object may 

change colour to reflect the new attributes. 
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Capture Shape 

 

Instead of using the polygon tool to draw new features the capture shape tool allows you to 

capture a feature directly from another layer and copy that into your data. This is particularly 

useful for capturing OS MasterMap features.  

Once you have chosen the Capture tool a dialogue window will ask which layer you wish to copy 

features from. Choose from the drop-down list. 

 

 

 

 

 

 

 

 

 

 



 

 

Page 163 of 213   Document date: 06/03/2025   © 2025 Arkance UK Ltd. 

Software: MapThat 

Document: MapThat_UserGuide_v6.4.3doc 

Then simply click in the map to choose an object from another layer and press Capture. In this 

example, we are selecting to capture a feature from OS MasterMap, and even though 

MasterMap is only showing as a background map, MapThat will capture its features for you. 

 

 

Once the feature is red-lined choose the Capture tool to create the object. 

 

If there are mandatory fields for the drawing layer the Attribute window will auto open, and you 

can enter the values as required. 

 

 

Once the attributes have been entered press OK and the to commit the new map feature press 

the Save button. 
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Merge Shape  

 

The Merge tool allows you to select two or more polygons and merge those into one feature. The 

Polygons have to be contiguous or intersect each other to be merged. Below is an example of 

merging two OS MasterMap polygons which we have created using the Capture tool. 

 

Firstly, in the map window choose the two features which are coincident, and the Merge Shapes 

menu will update to show the number selected. 

 

 

Once all the features are selected press the Merge button. 
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And the features will turn red. 

 

 

Now press the Done button to commit the Merge. 

 

 

You may need to edit the attributes of the merged features. 

 

 

Once finished ensure that you Save the changes. 
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You can also Merge Polyline features, for example two separate Polylines can be merged into 

one record. From the Merge options ensure you choose the Polylines radio button. 

 

The Polyline Objects must however touch each other before they can be merged into one, if not 

a warning message will be shown. 

 

 

Having selected the two Polylines, the Merge tool updates to state 2 Polyline objects are selected. 
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Choose the Merge button to perform the Merge. 

 

 

Then press the Done (tick) button to complete the merge and enter the attributes for the newly 

merged Polyline feature. 
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Finally press Save to commit the merge. 

 

 

 

 

Split 

 

The Split Features tool allows users to split an existing map feature into two separate parts.  
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Choose the Split Features button and at the bottom of the Drawing Tools the Split features 

section opens. 

 

1 – Select the Object Type to split i.e., is it a Polygon? Or Polyline? In our example we will choose 

Polygon. 

 

2 – Then in the map window, select the Polygon feature to Split.  
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3 – You can either Split the Polygon and create Two records or create Multi Part geometry for 

the original feature. 

 

 

4 – Now digitise a line through the Polygon features where you wish the Split to occur. 
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Once you have completed the Split Line, you should enter the attributes for the new features. 

 

 

 

 

 

 

 

 

Once the attributes have been entered choose the Done button and the feature will be saved. 

 

In the map you will now have two map features (records) instead of one Polygon. 
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Create Buffer 

 

 

The Create Buffer tool allows you to create a buffer of a set distance around either a newly 

digitised line or an existing line feature. This could represent the area around a planned pipeline 

or could be used to analyse incidents that fall within a distance of a bus route. 

 

 

 

There are two ways to generate the buffer fetaure, either using an existing line, or to create the 

new line on the fly. 

 

 

Existing Line 

In the first example we will create a buffer around an existing line feature in the map. To do this 

we will firstly zoom into the map to find the existing line. 
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In the Drawing tools choose the Create Buffer button from the advanced editing options. 

 

 

Now scroll down and in step 1 choose the first option – Use Existing Polyline. 
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Then in step 2 choose the Arrow button,.. 

 

 

… and then in the map left click to select the existing line feature and it will turn blue. 

 

 

In step 3 you can now specify the distance for the buffer e.g. 25 metres. 
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In step 4 choose the Create Buffer button… 

 

 

 

 

Then complete the attribute information for the new buffer feature. 

 

 

And when you press OK… the new buffer will be created, so press the Save button to commit the 

changes. 
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The new buffer feature has now been saved into the layer. 

 

 

Using option one, we have created a new buffer record, and also kept the existing line as two 

distinct records. 
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New Line 

In the second example we will create a buffer around a new line in the map. To do this we will 

firstly zoom into the map to find the location where the buffer is required. 

 

 

In the Drawing tools choose the Create Buffer button from the advanced editing options. 

 

 

Now scroll down and in step 1 choose the second option – Create New Polyline. 
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Then in step 2 choose the Draw a new Polyline button,.. 

 

 

… and then in the map left click to draw the shape of the new line, double left clicking to end the 

new line. 

 

 

In step 3 you can now specify the distance for the buffer e.g. 15 metres. 
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In step 4 choose the Create Buffer button… 

 

 

 

 

Then complete the attribute information for the new buffer feature. 
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And when you press OK… the new buffer will be created, so press the Save button to commit the 

changes. 

 

 

 

The new buffer feature will be saved into the layer. 

 

 

Note using this option we have created the buffer without the need to have an existing line 

feature. 
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Upload Documents 

 

The Document Upload Tool allows users to upload, preview, download and remove documents 

attached to any map feature. 

 

To Upload a document, simply choose the Upload Documents tool and then click on an existing 

map feature and the Document Upload window will open. 

 

 

 

 

 

 

 

Having clicked on a map feature the Document Upload window opens. 
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Upload Document 

To upload documents (either PDF or image files), you can drag and drop files into the blue box 

area or choose Select Files to open a file browser to find your files. 

 

 

 

Either select one or many documents in the file browser and choose Open. A preview of the 

document is shown below the Select files box, and because this is a PDF, the preview cannot be 

shown, but instead a generic PDF icon is shown. 

 

 

You can choose to delete the file from the upload using the trash can icon if required. 
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Or if you are happy to proceed, choose the Upload button to activate the upload process. 

 

Once the file(s) is uploaded a success message will be shown. 

 

 

You can also upload images, so choose Select Files again and select one or many image files, and 

then choose Open. 

 

 

The image files are added to the waiting tray to be uploaded. Notice that the previous PDF file is 

being shown to the right, as that has already been uploaded. 
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if you are happy to proceed, choose the Upload button to activate the upload process. 

 

Once the file(s) is uploaded a success message will be shown. 

 

 

 

Preview Documents 

Having now uploaded a PDF and some image files, on the right is the preview pane. This will 

show a preview of the file if it is an image, or a generic PDF symbol for any PDF documents. 
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To preview the other files that you uploaded choose the Next button… 

 

.. and the preview pane updates to show the next file(s) attached to the map feature. 
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Download Documents 

Having found the file that you wish to download, choose the Download button. 

 

The selected document or image will then be copied from the server to your local PC and may 

even open into a download window for you to view. 
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Remove Documents 

If there are any documents or images that need removing from the map feature, use the 

Next/Previous buttons to find that file… 

 

 

And then choose the delete trash can to remove the file from the server. 

 

 

 

 

Create Multi Type Geometry 

The MapThat Drawing Tools also allow users to create Multi Geometry data, including,  

• MultiPoints 

• MultiLines 

• MultiPolygons 

• GeometryCollection 
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Create MultiPolygons 

Once the Drawing tools have opened choose the Multi Geometry type from the list box e.g., 

MultiPolygon. 

 

 

Now use the Create tools e.g., Draw Polygon to draw the first polygon. 

 

 

 

Then continue to use the Drawing tools to add multiple geometry to this new record. Again, in 

this example we will add another polygon. 
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Once you have added all the Parts for the new feature, choose the Complete Geometry button. 

 

 

You will now need to enter the attributes for the new feature. 

 

 

Finally choose the Save button to commit the new record. 
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In the map window, the new MultiPolygon feature has been added. 

 

Note – you can use the Move and Reshape tools to modify this feature as needed. 

 

 

Add Part 

The Edit tools have options to Add and Delete Parts from any Multi Geometry record. In this 

example we will Add a Part to the new feature. 

 

 

 

 

Having activated the Add Part tool, the steps to follow 

are shown at the bottom of the Drawing Tools. 
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Firstly, select an existing Multi Geometry feature, here we have clicked and selected the one we 

just created. It will turn red. 

 

 

Next choose the required Create tool to add a new Part, in this example we will use Polygon to 

add a New Polygon Part. Left click in the map to draw the new Polygon. 

 

 

Once completed the new Part will turn red. 
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To commit the new Part, choose the save button, and the new Part is added to the existing 

MultiPolygon record. 

 

 

 

Delete Part 

The Edit tools have options to Add and Delete Parts from any Multi Geometry record. In this 

example we will Delete a Part from an existing Multi Geometry feature. 

  

 

 

 

Having activated the Delete Part tool, the steps to follow are 

shown at the bottom of the Drawing Tools. 
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Firstly, select an existing Multi Geometry feature, here we have clicked and selected the one we 

just created. It will turn red. 

 

 

Next from the Edit Tools choose the Remove button…. 

 

 

… and then left click on the Part you wish to delete. The Part will turn blue, and the message ask 

if you are sure you wish to delete the geometry? 
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Choose OK and then press the Save button to commit the change. 

 

The Multi Geometry record now has one less geometry Part. 

 

Note - The above Multi Geometry options also work with MulitPoint, MultiLine and Geometry 

Collection records. 

 

 

Filter Drawing Records 

If enabled, you can also use the Filter option at the top of the Drawing Tools, to filter your 

Drawing Layer, making it easier to find the feature you wish to edit. 
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Firstly, choose the Filter On field, and in this example, we will choose the Location value. 

 

In our example we have an area of grass on the roundabout, but below this is a Rosebed that we 

cannot see. So, in the Value we will type the word Rosebed. 

 

Having typed the value choose the Filter button to apply the filter to the map objects. 

 

The map objects are then filtered to only show features where the Location = Rosebed. 
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Now that the Drawing Layer is filtered, we can more easily see the map object that we wish to 

edit, in this case the Rosebed, and we can use tools such as the Reshape or Move tool, to make 

the required changes. 

 

 

Once you have completed your edits, choose the Clear Filter button. 

 

 

All map objects for the Drawing Layer are then re-displayed. 
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11.0 Report Generator Tool  

The Report Generator Tool is provided as a sub menu under the Edit Tools > Import Data menu. 

 

 

Having clicked Report Generator, the following menu is revealed. 

 

 

The Report Generator tool allows you to access any Report that you have generated e.g. a Con29 

Constraints Document. 
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Refresh List 

Press the Refresh List button to see any newly created Reports. 

 

 

Once the Report has been created the record in the list now updates with a Tick and the date 

time that the Report was ran. 

 

 

To view the Report, select it from the list, and press the Open button. 
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12.0 Printing 

 
MapThat has two methods for printing. You can save the current map as a PDF document, and 

there is a Scale Printing tool which will allow you to print a map to specified paper sizes and 

scales. 

 

 

Print to PDF: 

 

 

Having chosen the geographic location and the layers that you wish to see, simply press the Print 

to PDF menu, where you simply need to enter the name of the PDF map that you will create. 
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Then press the PDF button. 

 

And the map will open in the current web browser pane, where the layers, legend, copyright, 

and scale bar have been added. 

 

In the top right corner are two options, where you can choose to Print the PDF or Close the Print 

Preview. However, before you make a chocie you can also Pan and Zoom around the map to 

change the Print Preview. Below we have chosen to pan and zoom in to show the Planning Apps 

we wish to print. 
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Once you are happy with the Print Preview, click the Print icon in the top right to open the Print 

Wndow in your Browser.  

 

 

Using the Print Window, you can edit the margins, choose the paper size etc…and choose the 

destination to either send to a printer or to Save as PDF. Once saved the PDF can then be opened, 

and will show your map layers, a title, legend, copyright statement and logo. 

 

Scale Print Tool: 
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The second option for printing is the MapThat Scale Print Tool. This tool will allow you to define 

your area of interest, pick a map scale, paper size, template, and background map. 

 

There are two options, you can either create a new Print Job or open previously created Print 

Jobs. Firstly, we will create a New Print Job. 

 

• Orientation: Choose the paper size and 

orientation. 

• Template: Choose a pre-setup template at 

the chosen paper size.  

• Printer: Choose a connected printer or print 

to PDF. 

• Scale: Choose a map scale to print to, 

including the current scale. 

• Basemap: Specify the background map to 

print against. 

  

 

• Date: Edit the date if required. 

• Scale: Change the scale text being used if 

required. 

• Title: Edit the title for the print. 

 

 

 

To place the template within the map, press the Place icon. A Print Area Box will be located in 

the map so that you can see the Printable area. 
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If the Print Area shown in the map does not cover your layers, then you can simply move the 

map to a new location and then use the PLACE button to place the Print Area over your data. 

Once you are happy press the Print button to activate the print job. 

 

 

A message will appear stating that the print job has been created and a reference number has 

been provided. 

 

 

Your Print job will be ready in 2-3 minutes. If you printed to PDF, then you can view your Print 

File by pressing the Job Status button, where a list of your Prints will be shown.  
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This can also be accessed via the menu item, Scale Printing > Print Jobs. 

 

 

If there is no Tick next to your print job, you may need to refresh the list after a few seconds. 

 

 

Once the print job has been run the record in the list now updates with a Tick and the tip to say 

that the Job is Completed. 

 

 

To view the print job, select it from the list, and press the Open Print button. 
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The Scale Print will now open in a new web browser window, where you can choose to download 

it as a PDF or send it to a printer. 

 

 

 

 

Filter Scale Printing:  

If enabled, you can also use the Filter option at the top of the New Print menu, to filter records 

in any Layer before you run a Scale Print job. 
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Firstly, choose the Filter Layer option to decide which layer you wish to filter. In this example we 

will choose our Planning Apps layer. 

 

Then, choose the Filter On field, and in this example, we will choose the Location value. 

 

In our example we have an area of grass on the roundabout, but below this is a Rosebed that we 

cannot see. So, in the Value we will type the word Rosebed. 
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Having typed the value, choose the Filter button to apply the filter to the map objects. 

 

The map objects are then filtered to only show features where the Location = Rosebed. 

 

 

Now that the Layer is filtered, we can more easily see the map object that we wish to print, in 

this case the Rosebed, and we can continue to choose the Scale Print options to then run the 

print job. 

 

 

As soon as the Print Job is set to run, when you now choose another menu, the Filter on the Layer 

will be removed and all other map features for that layer will show. 
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If we check our new Scale Print PDF, we can see the layer was successfully filtered to only print 

the Rosebed feature. 
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DynamicMaps Training Courses 

Why not enhance your Open-Source GIS expertise by attending the following 

courses: 

 

Introduction to GeoServer (2 days) – 8 CPD Points  

This two-day intensive course introduces the core functionality of 

QGIS, taking you through all the tools you will need to get started 

with the software. QGIS is a free desktop GIS, providing the same 

GIS functionality as commercial desktop GIS solutions such as 

MapInfo or ArcGIS for Desktop. 

The course is delivered using instructor-led real-world examples 

where you learn by ‘doing’. 

The course covers topics including, getting started with QGIS, map 

navigation and general mapping tips, selecting and querying your 

data, applying symbology, data analysis and editing, accessing 

external data sources and cartographic output. 

 

  

  

Introduction to GeoServer (2 days) – 8 CPD Points  

This two-day intensive course introduces you to the core 

functionality of GeoServer, taking you through all the tools you will 

need to load, publish, and share geospatial data.  

The course is delivered using instructor-led real-world examples 

where you learn by ‘doing’. 

The course covers topics including, installation and configuration, 

familiarisation of the GeoServer user interface, publishing raster 

and vector data, map styling with SLD, applying attribute and 

spatial filters, connecting to WMS, WFS and WCS services and tile 

caching with GeoWebCache. 
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Open-Source GIS Integration (2 days) – 8 CPD Points  

This two-day intensive course introduces you to the core 

functionality of PostGIS, QGIS, GeoServer and OpenLayers, taking 

you through all the tools you will need to load, transform, spatially 

analyse, publish, and then share geospatial data.  

The course is delivered using instructor-led real-world examples 

where you learn by ‘doing’. 

The course covers topics including, installation and configuration 

of all software, loading vector data into a spatial database, 

connecting to a spatial database, and then undertaking GIS 

analysis, manipulating spatial data, publishing, and connecting to 

WMS and WFS services and utilising OpenLayers to design WebGIS 

solutions. 
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DynamicMaps Solutions 

DynamicMaps provide a range of web enabled GIS software solutions to help you 

maximise your use of geographic data: 

 

MapThat  

MapThat is a web-based mapping solution that allows organisations to 

run live queries on its business intelligence data to make more 

informed commercial decisions. 

MapThat has all the core mapping functionality, including ‘Where’s my 

Nearest’, ‘Location Finding’, ‘Thematic Styling’, as well as highly 

accurate data creation tools and its flexibility and interoperability allow 

you to connect to all your business information no matter what the 

data source. 

 

 

ReportIt  

ReportIt is a DynamicMaps WebGIS module to capture information and 

is the incident reporting module for DynamicMaps WebGIS and can be 

integrated in public facing websites and back-office systems where 

reports can be disseminated to engineers. By utilising a map-based 

reporting application you can save time and money through decreased 

public interaction and increased accuracy of incident location 

reporting. ReportIt can also be integrated with the Local Land and 

Property Gazetteer to ensure that locations have a unique record which 

can be selected either by entering part of the details or by finding them 

on a map. 

 

 

Address & Street Manager  

Address and Street Manager is a web-based solution integrated into 

the DynamicMaps Suite designed to manage your LLPG and LSG. 

An address record is the single most important and widely used piece 

of data by a local authority. DynamicMaps has been designed with this 

in mind. The Local Street Gazetteer (LSG) and the Local Land and 

Property Gazetteer (LLPG) modules were designed and built to directly 

comply and complement the BS7666 standard. DynamicMaps has been 

accredited with all the versions of the standard and is committed to its 

future development. 
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Street Naming & Numbering  

It is important that every address is unique and unambiguous so that 

the Emergency Services can find it quickly and mail is delivered 

correctly. The process of applying for, managing, and then validating 

SNN requests can be very manual. The DynamicMaps SNN Application 

is an online web portal for Applicants to submit and provide payment 

for their applications (with supporting documentation) and an 

Administration console where the SNN Team can then manage that 

application and all Correspondence from their desktop without having 

to undertake time consuming manual tasks. Successful and validated 

SNN Applications can then seamlessly be linked into your Local Land 

and Property (LLPG) and Local Street Gazetteers (LSG). 

 

 

 

 

 

Land Referencing  

DynamicMaps Land Referencing solution is used by Land Surveyors to 

streamline and manage their Land Referencing Projects. Utilising a web 

mapping interface, you can visualise HMLR Title Deeds, Interests in 

Land, Easements & Wayleaves and Environmental Constraints in order 

to optimise new Infrastructure Projects. Providing a project dashboard, 

you can manage project milestones, mitigate project risk, plan site 

visits, and integrate communication from all interested parties. 

 

 

Grounds Maintenance  

The Grounds Maintenance application allows facilities management, 

schools, hospitals, and housing providers to accurately maintain their 

Grounds Maintenance inventory. Linking directly to an online mapping 

application you can intuitively interrogate, manipulate, and update 

your Grounds Maintenance assets. The online management portal also 

provides Inspection Reports and Notices allowing you to streamline 

your communication between contractors and GM Officers. 
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GML Translator  

GML Translator is a software solution integrated into the DynamicMaps 

Suite designed to translate Ordnance Survey MasterMap (OSMM) and 

OS VectorMap Local into geospatial layers in your spatial database. 

Using the DynamicMaps GML Translator you can leave the translation, 

styling and loading of OSMM data into your spatial database to the 

experts, the resulting layers will be optimised for display and querying 

in your desktop or Web GIS. This service has the added benefit of saving 

you time processing heavy spatial datasets, thus allowing you to 

concentrate on undertaking your spatial analysis. 

 

 

Spatial Importer  

 
The Spatial Importer tool allows you to import GIS files, including, SHP, 

TAB, DXF, GeoJSON and KML, into an Oracle, SQL, or PostgreSQL 

database. You can import individual files, all files from a named folder 

and automatically migrate tables between multiple spatial databases. 

 

 

 

If you are interested in any of the above Geospatial solutions, then please visit the DynamicMaps 

website for more information: https://arkance.world/gb-en/products/dynamicmaps/ or alternately 

please contact info.uk@arkance.world 

 

https://arkance.world/gb-en/products/dynamicmaps/
mailto:info.uk@arkance.world

